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10  Principles of Working with
Drawings

In this lesson This chapter introduces the principles of working with drawings in Tekla Structures.

We will first explain the integration between drawings and the model. Then we will
introduce general arrangement (GA) drawings and create an example drawing from
the Basic Model 1 model (see the picture below presenting the steel frame). GA
drawings will be used as examples throughout this lesson.

We will also:

¢ Introduce other drawing types available in Tekla Structures
e Introduce the drawing list

e Introduce the various levels of editing the drawings

e Study the drawing objects and layout

e Plot drawings

e Introduce revision control
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10.1 Integration between Drawings and the Model

Tekla Structures stores all the important project information in one place, i.e. the
model. Drawings and other printouts such as reports, nc data files etc. are output

produced directly from the model.

‘\;23
N\

|
Y

Tekla Structures model

Drawings

The model contains all the important project information:

Parts' geometrical and structural information
Part marking

Bolts

Bolt marking

etc.

All the modifications must be done directly in the model. The model is always
modified in the Tekla Structures Model Editor.

The drawings are current views of the members contained in the model with added

definitions for:

the sheet size to be used
the way titles and tables are placed on the sheets
what is dimensioned and how

which marks are displayed
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e efc.
You can create drawings at any stage of a project.

Some of the drawing commands are located in the Model Editor and some are in the
Drawing Editor. You will find all the commands for creating and managing
drawings in the Model Editor. To view and edit drawings, you will use the Drawing
Editor.

Help: Drawing > Introduction to Drawings

Changes in the model members

Changes in the model members can result in the drawings no longer being up-to-
date. The following are examples of changes that affect the drawings:

e A part's profile or geometry changes
e Parts have been added or deleted
e The number of identical parts has changed

Tekla Structures updates the related drawings the next time you number the model.
Numbering does not have to be up-to-date to create or open general arrangement
drawings.
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10.2 Creating Drawings

We will now introduce general arrangement (GA) drawings and create an example
drawing of the Basic model 1 model.

General Arrangement (GA) drawings

Start GA drawing
creation

The Tekla Structures can be used to create general arrangement (GA) drawings.

GA drawings can contain several views, which can include the whole model or any
part of it. With the GA drawings you can create erection, foundation and other plans,
as well as details from views in the model.

You can create general arrangement drawings from one or several named model
view(s) with the following options:

e Create one drawing for each selected view

e Add all selected views to one drawing

e Create an empty drawing

You can create an empty drawing and add named model views to the drawing in the
Drawing Editor. The views must exist but they do not necessarily have to be open.

M/_  You cannot modify the appearance, such as the viewing
Q angle, of model views in the Drawing Editor. Therefore,
check and modify the appearance of model views in the
Model Editor before creating GA drawings. For example,
check that the plan views are really 2D views, and rotate the
rendered 3D views the way you want them to be shown in the
drawing.

See Lesson 12 for more information about creating GA drawings.
In the example below, we will create a general arrangement drawing from Basic
Model 1 by including several named model views in the drawing.

M'/_  You do not need to number the model, or update numbering
Q to create or open general arrangement drawings.

To create a GA drawing that contains selected views, e.g. 3d, GRID 3 and GRID A,
from Basic Model 1:

1. Open Basic Model 1.
2. Select Drawing > General arrangement drawing... from the menu.

3. Select the 3d, GRID 3 and GRID A views in the Create general arrangement
drawing dialog box. Then select the option All selected views to one drawing.
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X]

GRID 4
GRID &
GRID &
GRID 7
GRID B

PLAN +0

PLAN +3850

PLAM +732E0

PLAM +132400

[ ptamns:

i.-'-‘-.ll selected views to one drawing | IDrawing p[DpE[j:iES__I]

[ ] Open drawing

dialog box above by holding down the Ctrl key and picking

M/_  You can select multiple views (or toggle the selection) in the
; each view separately.

GA drawing views are automatically labeled with the current
view name.

With the One drawing per view option you can select all the
plan views in the dialog box, and create separate drawings
with predefined drawing properties all at once.

Define drawing To define the properties of the GA drawing:
properties

1. Click the brawing properties... button to open the General arrangement drawing
properties dialog box.

2. Select A1-BLANK settings from the option menu and click Load.

3. Give the drawing a distinctive name in the Name field, e.g. STEEL FRAME (or
CONCRETE FRAME if your model was made of precast concrete beams and
columns).

4. Click the view... button to open the General - view properties dialog box.
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[®] General arrangement drawing properties

[ Save | Load JlrBank v Toavess |latBLANK |

[FiName  [STEEL FRAME | |

Tite, | !
| |
| |

Lapout... [ WiEw ] Wwield. .

[ Fart. .. ] I Balt... J [ Meighbaor part. J

[ Part marl.., ] I Bolt mark... J

[+] [ Frotection... ] [ Connection mark... J [¥] [ Gnd... J

[Heinfurcement...] [Heinfurcemént markz... l Filter...

[ Compotent... ] [ Compotent mark... J

[ Ilzer defined attributes. .. I

[ 0k, l [ Apply ] I ccific [ Get ] [|7 f' |_J [ Cancel I

5. On the Attributes tab, change the drawing scale to 100 and click oK to apply the
scale and close the dialog box.

[# General - view: properties

[ Save J I Load ] l_?@ﬂﬁﬁ[?!_‘_’_! [ Save a3 ] | |

! Aittributes Shnrtenmg_ Lal:uel

Scale 1/ |1un.nnnn |

‘igw extension for neighbor parts: E_U.E":l

Reflected view E.HP'__V |

(o JCeeb ) e | oo |[F/T)[carea ]
If you have a steel frame If you have a concrete frame
6. Click the weld... button to open 6. Click the Reinforcement... button to open
the General - welding properties the General — reinforcing bar properties
dialog box. dialog box.
7. On the Content tab, set the 7. On the Bar content tab, set the Visibility
Visibility of site and workshop welds of all reinforcing bars to Not visible and
to None and click oK. click oK.
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[#] General - weldi ng properties

[ﬁ] [ﬂ] standard L E

Cantent | Appearance
"wheld number; Mo
Wizibility

Il SiteSworkshop: IN':'LI_

Weld size limit: 4.00
Placing

| ok || apeb || Modie |

8. Click the Filter... button to open
the General - filter properties dialog
box.

9. On the Parts tab, use the Filter by
Material field to filter drawing
objects so that no concrete parts are
shown. Enter k* as the filter string,
tick the Not option on and click oK.

[¥] General - filter properties

l Save ” Load ]standard

Objects (other thah component objectz)

Connection objects
Mumbers | Partz | Components | Reinforcing b
Filter b Mot Filker sting
Part
T Pl |:
[ Class Pl I:
[ Profile O [
b aterial IK_"_
[ Finish O |:
[] 5econdary / Main parts [ ] @

[

| ok ][ appl

[#] General - reinforcing bar properties
Save| | Load |standafd Vl Save az |:

Ear content | Bar appearance | Mesh content | kest

Yizibility of all reinforcing bars: Mot ViSiblEl
R epreszentation: zingle line

Symbal at straight end:

[—
Symbal at hooked end: —=
Vigihility of reinforcing bars in group: | bar in the mi

[ ok ][ ape |[ Medty |[ Get |[F

8. Click the Filter... button to open the
General - filter properties dialog box.

9. On the Parts tab, use the Filter by Name
field to filter drawing objects so that
only beams and columns are shown.
Click ok.

[®l General - filter properties

[ Save ” Load ]lstandard V|E

Objects [other than companent abjects)

Connection objects
Mumbers | Parts | Compaonents | Reinfarcing bars | User

Filter by Mat  Filker gtring
Fart
Mame [] [BEAMOR EEILLIMNI
[ Class Fl l—
[ Prafile O |
[ taterial Fl |
[ Finish O |
|

[ 5econdary / Main parts ] Secondary

| ok | sppb || Modiy |[ Get |[T

10. In the General arrangement drawing properties dialog box, save the selected
drawing properties with a unique file name, e.g. steelframe (Or concreteframe),
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by typing the file name and then clicking the save as button. Drawing property
files steelframe.gd and steelframe.gd.more are created in the ..\Basic Model
l\attributes folder.

[€] General arrangement drawing properties

[ Save ][ Load JEI-S_tE[?J.f_f_?[I'_I'IE .f_.i_.steelframe

Mame

steelframe. gd, more
steelframe. gd

11. Click oK to apply the selected GA drawing settings and to close the General
arrangement drawing properties dialog box.

For more information on drawing properties, see Help: Drawing > Drawing
properties.

Create and open To create and open the GA drawing:
the GA drawing

1. Select the Open drawing checkbox in the Create general arrangement drawing
dialog box to have Tekla Structures automatically open the drawing.

[ptiate

;.ﬁ.ll selected views ta one diawing v [Drawing prnperties___]

[¢] Open drawing

2. Click create.
3. Check that the created GA drawing is as shown below.

L=t e TT ---
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to the same GA drawing properties you applied. If some
views need different properties, you have to modify the view
properties afterwards in the Drawing Editor.

f All of the views in the GA drawing will be created according

M/_  You can first define the GA drawing properties by selecting
Q Properties > General arrangement drawing... from the menu,
and then load and apply the desired properties. After that
open the Create general arrangement drawing dialog box to
create the GA drawing with the selected views.

Other drawing types

In addition to general arrangement drawings, four other types of drawings can be
created in Tekla Structures. These will be presented in greater detail in Lessons 11
and 13.

Single-part drawings are workshop drawings of individual steel parts. Drawings can
be produced for any steel part in the model. The single-part drawings can contain
holes but welded parts cannot be included. This drawing type is available in Steel
Detailing module.

Assembly drawings are typically workshop drawings where details of an assembly
consisting of steel parts are presented for fabrication. In most cases, an assembly
consists of single steel parts that are either bolted or welded to the main steel part.
This drawing type is available in Steel Detailing module.

Cast unit (CU) drawings are formwork or reinforcement drawings of reinforced
concrete structures such as foundations. This drawing type is available in the Precast
Concrete Detailing module.

Multi-drawings are workshop drawings which gather together several single-part or
assembly drawings on one sheet. This drawing type is available in Steel Detailing
module.

Lesson 11 Assembly and single-part drawings / Cast unit drawings

Lesson 13 Multi-drawings and multinumbering
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10.3 Drawing List

We will briefly cover the Tekla Structures drawing list.

You can use the drawing list to:

e Select and open your drawings for viewing and editing in the Drawing Editor
e Update, clone and delete drawings

e Update GA drawing marks

e Display and filter drawings shown in the list

e Choose drawings to select parts in the model, or show only the drawings of the
selected parts in the list (not available for GA drawings)

e Lock, freeze and issue drawings
e Add revisions to drawings
e Modify properties of several drawings at a time.

The drawing list also displays the creation and modification dates of the drawings,
drawing size and type, etc.

See Lesson 13 for updating GA drawings.

Opening and closing drawings

Open drawing list
and a GA drawing

You can only have one drawing open at a time. If you already have a drawing open,
Tekla Structures prompts you to save that drawing before opening the next one.

To open the drawing list and a drawing in Tekla Structures:

1. Select brawing > List... from the menu or click the Open drawing list icon on the
Standard toolbar.

il

2. In the drawing list select the previously created G [1] drawing.
3. Click open, or double-click on the drawing to open it in the Drawing Editor.
See also Help: Drawing > Getting started with drawings > Opening drawings.

When selecting GA drawings in the drawing list, the activated buttons at the bottom
of the Drawings dialog box are Open, Update marks, Delete and Cancel. The table
below describes their functionality.

Button Description

Open Opens the selected drawing in the Drawing Editor. You can only
select one drawing from the list at a time. If the Open button is
grayed, you have more than one drawing selected.

You can also double-click a drawing on the list to open it. See also
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Close a drawing

Button Description

Opening drawings.

Open Opens the previous or next drawing in the list.
next/previous

Update Updates frozen drawings, and recreates unfrozen drawings. Locked
drawings are not updated.

Update marks | Updates marks in selected drawings.

Clone... Clones the selected drawing for a similar part.
Delete Deletes selected drawings. You cannot delete locked drawings.
Cancel Closes the dialog box.

To close the drawing in the Drawing Editor:

1. Select File > Close drawing from the menu or click the cross in the upper right
corner of the drawing window.

2. Tekla Structures asks: Do you want to save the current drawing?

3. Select save or Save and Freeze to keep the changes that you have made to the
drawing, or close the drawing without saving by clicking No.

Question
'\?) Do pou want bo zave curent drawing?
I Save ] I Save and Freeze I [ Mo ] [ Cancel ]

Drawing list contents

All of your existing drawings are shown in the drawing list. The example below
shows the header line information that is available in the drawing list.

[®] Drawi ngs

|' lezue  Lock | Freeze Uptodate  Created tMadified Revigion Size Tupe | Mame Title
| U5 022004 002 2004 dalrhEd G 1] STEEL FRAME

See also Help: Drawings > Getting started with drawings > Drawing list.

The table below explains the header line items of the drawing list.

Item Explanation

Flags Flags are characters (I, L, F, n, *, etc.) at the beginning of each
row. They indicate the drawing status.

Copyright © 2005 Tekla Corporation TEKLA STRUCTURES BASIC TRAINING 13
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Item Explanation
Dates The creation and modification dates of the drawing.
Revision The revision number or mark of the drawing.
Size Paper size, which is shown automatically.
Type The drawing types are identified by the following letters:
e W for single-part drawings.
e A for assembly drawings.
e C for cast-unit drawings.
e G for general arrangement drawings.
e M for multi-drawings.
Mark The drawing mark is the number of the part from which the
drawing was created. You cannot change drawing marks.
Name You can add a drawing title using the Name field in the drawing
properties dialog box.
Title 1, Title 2, | Add extra drawing title fields to the drawing properties dialog
Title 3 box.
User-defined Include up to 20 user-defined attributes in drawing lists.
attributes
N You can sort the order of the drawings by clicking the desired

Q header line button in the drawing list.

You can adjust the column widths of the drawing list and
Tekla Structures will keep the changes.

Drawing status flags

The status of drawings is represented by flags, which are shown on the left hand side
of the drawing list.

For more information about drawing status flags, see Help: Drawing > Getting
started with drawings > Drawing status flags.

Lock and Issue flags can be manually added to the selected drawings. The M flag
appears automatically on issued GA drawings that have been modified.

N Lock GA and other drawings from being accidentially

Q deleted or changed.
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Use the buttons on the right hand side of the drawing list to change the status of a
drawing. Alternatively, select the drawing in the list, right-click to open the pop-up
menu and change the drawing status.

[ﬂ.rDraw'ings
lzsue Lock F | U Created Modified Revision Size Type | Mark Ll
16.03.2005  00.00.0000 1152+ 828 G 1]
16.03.2005  00.00.0000 830 534 G [2] Fiter
16,003, 2005 16.03. 2005 1152 828 G [3]
- — .
Properties... Alt+Enter
Revision... Chrl+R
Lock
B
Copy drawing views with layout Freeze
Link drawing wiews with layout
P% —
fesue ’ Rewizion
< Redo Chrl+y >
[ Open ] [Dpen Previous] [ Open Next]
Lock a GA To lock and unlock a GA drawing:
drawing o ) .
1. Select the G [1] drawing in the drawing list.
2. Click the Lock - On button and the L flag will appear.
3. Try to delete the drawing by clicking Delete.
4. Try to open the drawing by clicking Open.
5. Click the Lock - Off button to reset the lock.
6. Click open. The drawing opens in the Drawing Editor.
You cannot open or delete a locked drawing without unlocking it.
Issue a GA To issue a GA drawing:
drawing o o
1. Select the G [1] drawing in the drawing list.
2. Click the Issue - On button and the | flag will appear.
3. Open the drawing to view the GA drawing title.
4. Check that the issue date is shown correctly in the drawing title.
Copyright © 2005 Tekla Corporation TEKLA STRUCTURES BASIC TRAINING 15
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10.4 Drawing Levels

You can edit drawings in the Drawing Editor on three levels:
e Drawing properties

e View properties

e Object properties

For more information about the drawing properties and different drawing levels, see
the following help files:

Help: Drawing > Introduction to drawings > Three levels of editing drawings
Help: Drawing > Drawing properties
Lesson 12 GA drawings

Modify drawing properties

Modify part's
color on drawing
level

On the highest level you can change the drawing properties, which affect all of the
objects in the drawing.

To change the GA drawing properties, e.g. the color of parts, in the Drawing Editor:

Select Properties > Drawing... on the menu or double-click on the drawing to
open the General arrangement drawing properties dialog box.

2. Click the Part... button to open the General - part properties dialog box.
Select the Appearance tab.

4. Change the Color of Visible lines, €.9., to green. Check and see that the checkbox
is marked with a tick.

[ Save ” Load ]gta_nc_la_rd_E: Save az | |

Enntent .-’-;xppearanc:e |

WVisihle e
Calar: | — :|
[] Type:! | |

Hidden linez. Center ine

I:l EDID[; ! — v |
L] Type: | sha ~|
Refererce Lines
[] Ealar; | e— v I
I:l Tupe; ! b v |
| ok || ey || Modiv || Get |[F /T[] cancel |
Copyright © 2005 Tekla Corporation TEKLA STRUCTURES BASIC TRAINING 16
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Change grid
visibility of many
GA drawings

5.

Click Modify and OK.

Create another GA drawing by following the steps described in Chapter 10.2

Creating drawings. Select different views, e.g. the PLAN +0 and PLAN +13400

views, to be included in the drawing.

To simultaneously change the drawing properties, e.g. grid visibility, of more than

one GA drawing:

1.

2
3.
4

Type

5.
6.
7.

Open the drawing list in the Model Editor.
Select two GA drawings in the drawing list by holding down the Ctri key.
Right-click to open the pop-up menu.
Select Properties... Or press Alt+Enter as shortcut to open the General
arrangement drawing properties dialog box.
Tiae Tie i
STEEL FRAME | Lo J[ mven |
[2] Cpen Chrl+o Filter
Update Ctri+l) | Selected | l Up to dake |
Plat. .. Ctrl+F
Expart... Ctrl+E I Select parts J [ By partz I
Properties. . Alt-+Enter Lok
Revision..,  Ctrl+R o
Delete Del [ On J [ ot ]
Drawing p Il  Fieszs
[ on || of |
Lock: 4
Freeze » Izsue
Issue 4 [ On ] [ O ]
Undo Ctrl+2 Revizion
Redo Chrl+Y [ Bevision... ]

Click the Grid... button to open the General - grid properties dialog box.
Click the on/off button to clear the checkboxes.
Change the grid visibility to Not visible.

TEKLA STRUCTURES BASIC TRAINING
Principles of Drawings
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[®] General - grid properties

(o ) (o) (mm ][
Grid; N cutv_ml:ule v_ |I
Test placing
Grid fine
N
Tt
300
|.l’-'~rial
183
Im:nn
I oK H Apph ” M iy ] [P!I‘][ Cancel J

8. Click Modify and OK.
9. Click oK to close the General arrangement drawing properties dialog box.

10. Open the modified drawings one at a time to check that the changes were carried
out correctly.

Whenever possible, you should modify drawings by changing
the drawing properties. These modifications also remain

when the drawing is recreated due to a model change.

Modify view properties
The second level is to edit the view level, where you modify the selected drawing's
view.

Modify properties To present hidden lines of adjacent parts and to add part marks to the GRID A view
of selected view of the G [1] drawing:

1. Double-click on the border around the GRID A drawing view to open the View
properties dialog box.

Show hidden lines

! Click the Part... button to open the View part properties dialog box.
of parts

2
3. Select the Content tab.

4, Click the on/off button to clear the checkboxes.
5

Turn the Hidden lines option on. Check that the checkbox is marked with a tick.

Copyright © 2005 Tekla Corporation TEKLA STRUCTURES BASIC TRAINING 18
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[®] view part properties @

[ Save I |_ Lioad I | Vl [ Save az ] ! |
| Content i_:f_i';.EPearance._;

Fart reprezentation Hidden lines:
] | Dutline w | [¥]Hidden lines: anioff
[ Sumbol uffset: l—.“jm—l ] Dwrehidden lines: ] ondoff
[] lnner contours: andoff

Center line Reference Lines

Beam  Flate Palygon Beam Plate  Polygon

Ml .

Manpat [ [ [
Secpat [ [ [

Mainpat [ [ ]
Secpatt [ [] =]

Additiaral mark s

[] Grigntation marks; [Jondaff
[] Connecting side marks: [ anidaft
[ 0k l [ Apply ] [ adify l [ Get ] [|7 f I_] I Cancel

6. Click Modify and OK.

Change part mark 7. Click the Part mark... button to open the View part mark properties dialog box.

content
8. On the Content tab, remove the <<Assembly position>> from the Elements in

mark list for the main parts, and add Profile to the list.

[®] view part mark properties

5ave| [Load] [fiter_beam main_pats v [5aveas] |
! Content i_-lj.eneral___
Content
| W air part Ao |
Available elements Bl e Frame:around elements
Azzembly poztion P
Part position e < Add frame
T — —
b aterial Tope: :._v_.
Mame e -
Class Calor: |-_' v|
Size
Lenath [ Add > Fort
Carnber = —
Fittiingz [M5/F5) Calor: | Green v_|
Face direction ; e ;
Height: {250 |

[rage of outzstanding le;

Center-to-center distari
|l zer-defined attibute | Forit:

!f—‘n.rial Mt |[ Celect.. ]

:
Syl
:

| | £ | 3| | Move doin |

[ ok J[ seeb | Modiy [ Get ][p,’f-]
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9. On the General tab, change Visibility in view to always and click Modify and OK.

[l Vipw part mark properties

5ave] [ Load] fter_beam_main_parts | [save as]

| Content | General :

Vigibility of mark

Wisibility in view: lalwaps v
[(] Paits outof view plane;  |Visible v
[] Merge marks: Elff |

Frame around mark
Clee (G20 9
[Calor: | -

Leader line

Otwe. [ =(7) v

(]

amow: | ——

Flacing

|:| Place...
[ ok J[ seoy ][ Modiy |[ Gt |[F/T ]

The GRID A view should now show the hidden lines of adjacent parts and part
marks representing the main part profiles.

GRID A

|
|
|
!

=
|
|

—i)_m_-a R
=l

oo
i

M1/_  Dashed line type in part mark frames and leader lines indicate
Q that the object is behind another object in the drawing.
Copyright © 2005 Tekla Corporation TEKLA STRUCTURES BASIC TRAINING 20
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_______ | /
~FPL10°320 - [IPE600]~
i — r—lr-l I.,
L.E_I - @; _
| [FPL10*320
Modify object properties

The third and lowest level is to edit at the object level, where you change individual
objects in the drawing.
Modify frame and  To change the properties of a single part mark:

leader line of a
single part mark 1. Inthe GRID A view, double-click on the part mark of the RHS profile (diagonal

brace) to open the Part mark properties dialog box.
2. On the General tab, change the frame and leader line types as shown below.

[#] Part mark properties

ztandard W standard

Caontent | General

Frame around mark.
T_Irlpe: W

[JColor; | e—

Leader line

Type: |~ v

[ asrraes: - b

3. Click Modify and oK. The part mark should now look like the following.

------- (ROST50*150*5 )
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10.5 Drawing Objects

In Tekla Structures, the term drawing object refers to lines, rectangles, arcs, circles,
poly-lines, polygons, clouds, symbols, text, DWG/DXF files, marks and dimensions.

General arrangement drawings are not automatically dimensioned in Tekla
Structures. Therefore you need to dimension GA drawings manually. In addition,
you may want to include additional drawing objects for temporary and/or revision-
related information, e.g. clouds and text.

For more information, see Help: Drawing > Editing drawings.

Create Drawing Objects

Create manual
dimensions

In the G [1] drawing, we will manually dimension the location of the diagonal
bracing connection and add a cloud and a note text to the connection.

To add manual Y-dimensions to the diagonal bracing connection (on gridline 3) in
the GRID A view:

1. Set the snap settings on the Drawings: Snap settings toolbar as shown below.

Drawings: Snap sektings

@ aofax] OEE

2. To enable the tentative snap, which helps with the selecting of points, check that
the Xsnap is set on in the Setup menu.

W AEMAD
SmartSeleck 5
v Middle button pan CEFlHM

Crossing selection

3. Click the Create y dimension icon on the Drawings: Dimension toolbar.

i

4. Snap, first, to the center point of the connection created between the four
diagonal braces, and then to the intersection of GRID 3 and GRID +0. Move the
cursor to the left side of GRID 3 to select the location of the dimension line. End
the command with the middle mouse button.

5. Snap again to the center point of the connection and then to the intersection of
GRID 3 and GRID +13400, select the dimension line location and click the
middle mouse button.

6. Select both dimensions (by holding down the ctrl key), right-click and select
Combine dimension lines on the pop-up menu. The separate dimension lines are
now combined to one dimension line. Select the dimension line and move it to
the correct location by dragging with the mouse.
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Create a cloud

Inkerrupk
Properties. ..

Delete
Freeplace

Copy
Move

Add [ remove dimension poink

Combine dirension lines
Remove dimension poink
Set dimension zero poink

UCZs 3
Zoarm k
Ilpdate window

ek windoiw

o I _
E450) | [IPEAS0]

[PEBO0]

[IPEA5D) IPEASD)

You should now have the vertical location of the diagonal brace connection shown
in the GRID A view (see the figure below).

Al

IPEGO0 [FPL107320} IPEBEJO ~

[FPL107320|

HEA300

3

HEA300

Copyright © 2005 Tekla Corporation

To add a cloud and a note text to the GRID A view:

HEA300

1. Click the Snap to any position icon on the Drawings: Snap settings toolbar.
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Drawings: Snap sektings

o d |ii-ﬁ y.ﬁ.utn |

2. Click the Draw cloud icon on the Drawings: Drawing toolbar.

Drawings: Drawing

0% O 7 @~

3. Pick points for the cloud position around the diagonal bracing connection on
gridline 3. End the selection with the middle mouse button.

oE
1 .
\@T\ 3
X
6
5 _; 4

Create anotetext 1, Select Properties > Text... to open the Text properties dialog box.
for the cloud . . .
2. Select the standard settings from the option menu and click Load.

3. Change the text properties and frame as shown below and click Apply and OK.
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[F.l Text properties

Save [E] ?f}iﬂdﬂj VI [Save as] Istandard |

! f;‘-.ppearance |
Text
Test 'HOLD |
Colar; | m— :l
Height: 300 |
Font: E..-.’-':ri;a.l-ﬁérmw ! ’ Select., J
[+] &ngle: :I:_IQ
Frame Arroi
Type: I — &
Leader line: FJEI__V_I — |2DD—|
Color, ’_—vl M — :_2_5|:|_|
Flacing
[ oK, ] [ Lpply ] hecdify [a [|7 i I'] ’ Cancel

4. Click the Create text with leader line icon in the Drawings: Drawing toolbar.

Drawings: Text

ETO

5. First, pick an edge of the cloud as the origin of the leader line and then another
point to place the text.

The GRID A view should now look like the figure shown below:

R
| l l | | l l
| | | | | | |
; Exm] /Easﬁll Ex] Fs@ E /E;;E/Ea@ ‘ fEEeg] ‘ =) i | [FEsig]
4 T
————— e 7 e T B - - - - -
| == I
[FEL1&F320]

I
[EFL1E3z0] |2
|
|
|
|

N & == ==l
————— f[—-— === th £ -1 -
| | A !
I | . I -
————— ===~ o= - SR — - — F-—-—-—-—-1 ﬁ ---------
I | ¢ _ [
ﬁ I il 3 ﬁ I
LY i 4 4
I i "y I
***** R i b R o
| 1 1 | |
| 1 1 | |
(&) (€3] G

6. Select File > Close drawing and click Save in the Question dialog box.
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10.6 Drawing Layouts

Now we will have a brief introduction on how the Tekla Structures drawing layouts

function.

A drawing consists of the layout and drawing views, e.g. plans, side views, and

section views. A layout connects a set of table layouts and a set of drawing sizes.

Before you create a drawing, you must select a layout.

The example below illustrates the relationship between the table layout and drawing
views. The drawing views are blue, and the elements of table layout are red.

TIAlgin
_. o[- || | Frames
top view Lo
—-|—|- = Fold-
TCE T
= mark
front view —,[ ,! ,! i N
key plan
revision table Table
| section . section \\ Lay out
B wiew view I
E Y E* B-B material List | drawing title

See the following links for more information about drawing layouts:

Lesson 12 GA drawing

Help: Drawing > Drawing layout

View contents of a drawing layout

An example of a GA drawing layout for the A3 drawing sheet size is shown below.

The drawing title and revision table included in this layout are also shown separately

and enlarged.
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View GA drawing
table layout

Revision table:

[ e S JEweooaTe

* TEKLA Structures ®

T=
I
lr

1

A

Testing

21503

REW Mo

REW MARK

REVISION DESCRIFTION

REVISION DATE

Drawing title for GA drawings:

REV No | REV MARK

| REVISION DESCRIPTION

| REVISION DATE

°$’ TEKLA Structures ®

DRAWING TITLE

A1 GA-drawing

CONTRACT

Tekla Corporation

MODELLED BY

ISSUE DATE 00.00.0000

CONTRACT NO

SCALE

DRAVWING No

G [2]

REVISION No. o]

To view the contents of the GA drawing table layout in the Model Editor:

1. Select Properties > Layout... from the menu to open the Layout dialog box.

2. Select ga in the list of Layouts and click the Table layout... button to open the
Table layouts dialog box.
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el Layout

Lapaoits:
TR ‘ Current layout
eaEl Table [ayout...
! ]
Wwalt1 Fived zizes...
single
Calzulated zizes...
ga |

o ) o ]

3. Select ga in the list of Table layouts and click the Tables... button to open the
Tables dialog box.

(#l Table layouts

Table layouts: Current tsble lapout
Margite
| A el ] | e
| S | idth: (1000 i
mAlCipart ; e e
Height: | 10.00 |
Spaces
Horizontal | 10.00
Yertical: |_1 0.00 |
Tables...
£ |
[ Add J|_ Update ]|_ Delete ]
T | "

4. The content of the ga table layout is presented in the Chosen tables list.
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[F: Tahbles

Available tables:

Chozen tables:

DWG/THF

Eeyplan

aszembly bolt list
aszembly list
assenbly part list
aszembly stud li=t
call off

cast_unit list

cast unit part list

< i " =

drawing title ga
revision

o

Current table
Fieference

&

| Drawing framme hd |

1

Vector betwesn corhers

]

Ipdate

Tahble

Ol

: iD.EIEI

Scale: 11.0000

w |00

Transparent [ ]

[ ok [ e |

Cancel

5. Select the drawing_title_ga and revision table one at a time to view their location

in the table layout. The former, for example, is bound by its lower right corner to

the lower right corner of the drawing frame (that is the reference object).

[#f Tables
Available tables: Chozentables:
DG /DXF T: [rawing vivlie o=
KEeyplan '_ rewlslomn
assembly bolt list =
assemhly list
assenbly part list E]
assenbly stud list
call off [E]
cast_u.nit_lis'::
cast unit vart list :
i &
Update
Curent table
Reference Tahle
] S hS [
: Drawing frame v ' | diawing_title ga
A ]
YWechor behwasn comers i 1
PRI e Secale: {1.0000
S {D.D.EI L |
s Transparent
(000 pesent |
T T
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6. Click cancel to close the dialog box.

Create a new layout

Create a new GA
drawing layout

We will use the existing ga layout as basis for creating a new layout for GA
drawings.

To create a new layout:

1. Open the Layout dialog box from the Properties menu.

2. Select ga from the list of Layouts and type a name for the new layout (as shown

below) and click Add.

[l Layout

Lapouts:

assemhly
o

multi
single

| 0a_ e

l

ok | Apply |

Current [apout

Table layout. ..

Fized sizes...

Calzulated zizes...

Caricel

open the Table layouts dialog box.

Select the newly created ga_new layout in the list and click Table layout... to

Select ga in the list of Table layouts and type a name for the new table layout (as
shown below) and click Add.
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[ﬁ' Table layouts

Current table lapout
Margirs

| assembl | ’ —
widh  [1000 |

Table layouts:

Hattipars Heght  [1000 |
Spaces
Harizontal: |1IJEIEI—|
Vertical: 1 DFEI—|
\ga_new i

[ Add ” Update ]I Delete ]

ox ) o )

5. Select the newly created ga_new table layout in the list and click Tables... to
open the Tables dialog box.

6. Select drawing_title_ga, revision and tender_document one at a time in the
Available tables list and add them (using the arrow button) to the Chosen tables
list.

[l Tables
Avvailable tables: Chozen tables:
rebar schedule SWE Al drawing title ga
rebar schedule US revision
revision tender document

single note
il _T1d=t

[#]#]

| tander document

workshop 1n assembly 131 -

workshop part list

v
s D @ |
Current table
Reference Table
L] 3
I gDrawing frame b | I ' | |
] I i) 1

i I’ﬂ'ﬁ '''''''''''''' j Scale: I1DDDD |

Transparent [

Cox ) )

7. Set the location and click Update for each table separately (as shown below).
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Define drawing
sizes for the new
layout

pdate

Current table
Reference Table
ul |l |4 [l
. Dawigfame  v| [daing file_ga
I 1
|Ipdate
Current table
Reference Table
[l ] ]
diawing file_ga v revision
il e a

|Ipdate

Eurrent tabls
Feference Table
O O 1
E[gy_i_s_i;ur_ju ; v :.tender_du:ucument i
] Tl Tl

8. Click ok to apply and close the Tables dialog box.

9. Click update in the Table layouts dialog box to update the ga_new table layout
and click oK to close the dialog box.

10. Click ok to close the Layout dialog box.

The new layout settings were saved with the file name ga_new.lay to the ..\Basic
Model 1\attributes folder.

Before using the new layout, we need to define drawing size where it will be used.

In Tekla Structures, you have two options how to set the drawing size. You can
either:

e Specify exact sizes for drawings.

e Let Tekla Structures find appropriate drawing sizes (according to the layout,
tables in it, and the drawing view scales).

To define fixed drawing sizes:
1. Reopen the Layout dialog box from the Properties menu.

2. Select ga_new from the list of Layouts and click Fixed sizes...

TEKLA STRUCTURES BASIC TRAINING
Principles of Drawings

Copyright © 2005 Tekla Corporation

32



2 Layout

Lapauts:

aszeuhly Current lapout

o Table layout...

oa

T Fiedsies. |
mialtdi

zingle Calzulated zizes...

|ga_new |

[ Ok H Apply I Canicel

3. Inthe Fixed sizes dialog, type name ga_new_A3 for new size, define width and
height for A3 size drawing (410 x 287), and click Add.

m Fixed sizes

Fized sizes:

ad Current zize ————
al Yfidth: [410.00 |
al . —_—
o Height: 287.00 |

T able layout: W

ga new A3

-3 |
[ Update J[ Delete J

o ) e )

4. Select ga_new from Table layout pull-down menu and click Update. You have
now defined ga_new_A3 size to use ga_new layout.

Curment size
Wwidth: 410.00 |
Height: 287.00 '

T able layout; P
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Use the new GA

drawing layout

5. Repeat steps 3 and 4 for ga_new_A4, drawing size A4 (287x200).

6. Click ok to close the Fixed sizes dialog box.

7. Click ok to close the Layout dialog box.

To define calculated drawing sizes:

1. Reopen the Layout dialog box from the Properties menu.

2. Select ga_new from the list of Layouts and click Calculated sizes...

(el Layout

L apouts

assenbly
ou

ga

multi
single

gamew |

Lok J[ Aeeb |

|3a_new |

3

Curent lapolt

Table layaut,..

|| Calculated sizes. . I

Cancel

3. Connect all sizes to ga_new layout by selecting ga_new from pull-down menu.

[F.[ Calculated sizes

Size calculation
Increazing step

it 297.00 ]
Height: 210,00

b awirnurmn zize

wiidth: | 2000.00 il

Height: (540,00 I

Lok J[ eew |

Conpectad table |auogts

Siefd  |panew |

Size A3 |ga new (e |

Height = &3 Ig@__new |

Height > 43 |

Cancel

4. Click ok to close the Calculated sizes dialog box.

5. Click ok to close the Layout dialog box.

To use the newly created GA drawing layout:

Open the drawing list and double-click on the G [1] drawing to open it.

2. Open the General arrangement drawing properties dialog box and click on the

Layout... button.

3. Inthe General - layout properties dialog box, click on the on/off button to clear

the checkboxes.
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4. Select the ga_new in the Layout and Table layout fields and click Modify.

[®] General - layout properties

BT | [T |
Laout: |ga_new w
Drawing zize
[ 5ize dafinition mads: fS_EECifiEd size ~|
Sutozize -Specihied size :
Fixed sizes [] Dirawing size: BEDDD | * 584EIEI _
T able layout: _ w
[ ok || ey || Modiv || Gt |[F/AT]| Concel |

5. Check that the drawing layout is changed correctly. The drawing title should be

present in lower right corner of the drawing, the revision table and the note

TENDER DOCUMENT is as shown below.

TENDER DOCUMENT

REVNO| REV MARK. |REVISION DESCRIPTION

| REVISION DATE

~ TEKLA Msteel®

DRAWING TITLE STEEL FRAME

CONTRACT

MODELLED BY

ISSUE DATE 00.00.0000

CONTRACT NO

SCALE 1:100

DRAWING No G [1]

REVISION No. o]

When the drawing is modified so that the whole drawing needs to be recreated, the

drawing views are rearranged. As a result the views are placed differently thane they
were before (see picture below). We will now rearrange them manually.
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TENDER DOCUMENT
T

[EI=T ==

Move drawing To move drawing views:
Views .
1. Select the view frame of GRID 3.

2. Hold down the shift key and drag the view with the mouse to the right side of
the 3D view.

3. Move the GRID A view correspondingly
Your G [1] drawing should now look like the one shown below.
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TENDER DOCUMENT

B ———

< T

M/_  You can place drawing views more accurately by aligning
Q them horizontally or vertically. For instructions, see Help:
Drawing > Editing drawings > Working with drawing views >
Aligning drawing views.
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10.7 Plotting Drawings

Tekla Structures plots drawings both to selected print devices and to files. Single
drawings can be plotted from the Drawing Editor, and single or multiple drawings,
which have been selected in the drawing list, can be plotted from the Model Editor.

Plotting
(Fj’lot asingle GA To plot a single GA drawing from the Drawing Editor:
rawing o . .
1. Open the G [1] drawing in the Drawing Editor.
2. Select File > Plot current... to open the Plot dialog box, or click the Plot icon on
the Drawings: Standard toolbar.
3. Select the print device (plotter) to be used and click Print.
[ plot
Flotters:
[ ] Plat tia file
|Drs - -
LHE |
designjet_al i
[designjer al "
i Saling
laserjetdw ad
%) Auto
() Scale |_'I .00
Muriber of copies: |1 » !
Drientatiorn; !:-f-:y_t_u_:u_ . \_-'_E
Plot area: [Entire chaning |
Framesz...
Prirt ] [ Printer Setup... J Cancel
For more information about available plot options, see Help: Drawing > Printing >
Plot options.
Plot multiple GA To plot multiple GA drawings from the Model Editor:
drawings

1. Open the drawing list.
2. Select at least two GA drawings in the drawing list.

3. Click on the Plot icon on the Standard toolbar.
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4. Select the print device to be used and click Print.

each drawing to the device with the smallest paper size, on

\\Q" _ If you select several print devices, Tekla Structures sends

which the drawing will fit.

For more information about printing to print device, see Help: Drawing > Printing >

Printing drawings.

Plotting to a file

Plot a GA drawing

as a dwg file

To plot the G [1] drawing to a file:
1. Open the drawing list in the Model Editor.
Select the G [1] drawing in the list.

2
3. Click on the Plot icon to open the Piot dialog box.
4

Select DWG as the plotting format in the Plotter list. Check that the Plot to file

option is marked with a tick.

5. Type \drawings in the plot file name field below the Piot to file option. This will

define the ..\Basic Model 1\drawings folder as the destination folder of the plot

files.

(%] Plot

Flatters:

: i

|DHF
designjet_al
designjet_al
laserjetdwv al
laserjetdw ad

Pritit ] [ Printer Setup...

Flat toi file

Adrawings

| Browse. ..

[ Inclade revizion mark to file name

Scaling
(%) Auta
(i Scale [1 oo :I
Murmber of copies: I'I -_ 'f_i
Erientation: |E«9tu_ :'
Plot area; [Enire chawing v/ |

Framez...
Cancel

6. Click Print to plot the drawing to DWG.

7. Give a particular plot file name by typing, e.g., ..\drawings\SteelFrame.dwg in the
plot file name field, and click Print.
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2 Plot

Plattars:

! 5 Plot ta file

LG i ] 1

e |."u:|raW|ngs"~SteelFrame.d | [ Browse, . ]

designiet_al
designiet_al
lazerjetdv al Sicaling
laserjetdwv_ad

[ ] Inchude revizion mark to-file name

(%3 Ao

S Ecale 1.00 |

8. Check that the drawings were successfully plotted to the ..\Basic Model
1\drawings folder. This folder should contain the saved *.dwg drawings.

you have chosen several drawings, Tekla Structures uses the
drawing name(s) as file name(s). If you do not enter a folder
name, Tekla Structures creates the file(s) in the current model
folder.

You can also print a drawing to DWG using the Drawing
Editor. Open the selected drawing and follow the above
steps, starting at step 3.

\\Q'// If you do not enter a file name for the destination plot file, or

Tekla Structures does not distinguish between upper and
lower case letters. For example, a drawing named A.1
overwrites a drawing named a.1.

For more information about plotting to file, see:
Help: Drawing > Printing > Printing drawings > Printing to DWG/DXF
Help: Drawing > Printing > Printing drawings to file

For more information about defining drawing plot file names and plot directories,
see:

Help: Drawing > Printing > Printing drawings to file > Switches for naming plotfiles
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10.8 Controlling Drawing Revisions

Now we will cover the revision handling features of Tekla Structures.
When the model changes:

e You have to update or revise drawings

e Attach revision information to the drawings.

Tekla Structures displays the revision information alongside the revision number or
the mark in the drawing list and in the revision table within the drawings. The
revision table also shows the revision date. You can create a list of revisions in a
report.

For more information about drawing revisions and creating reports, see the
following links:

Help: Drawing > Getting started with drawings > Working with drawings > Defining
drawing revisions

Lesson 8 Numbering and reports

Create, modify and delete revision marks

Create revision
mark

To add a revision mark to the G [1] drawing:

1. Modify the model by changing the profile of the columns on gridline 1 from
HEA300 to HEA320.

2. Open the drawing list in the Model Editor.

3. Select the drawing to revise, right-click and select Revision... to open the
Revision handling dialog box.

[?‘1' Drawings
. lzsue Lock F U Created Modified Revizion Size Type  Mark | Hizglat
16.03.2005  00.00.0000 1152+ 828 G 1] |
16.03.2005  00.00.0000 530+ 584 G [2] | Fiter
[ 3 1152828 G 3 |
| SD:nt EEF:"‘S 032005 ] G 4] Selected Up to date
pdate tl-+
Export... Chrl+E Lok
P ties... Al+Ent
Delete Del Freeze
Draving >
Lok, 3 lssue
Fresze >
I 3
SSUe Fevizion
| | Redo Chrl+y | 2|
pdate [ Update marks I I Clone... ] [ Delete I

4. Enter the revision mark, revision date and description text of the revision in the
dialog box as shown below, and click Create.
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[#] Revision handling @
»

EES & T
Date:  |16.3.2005
Text Prafiles have been changed

[ M odify ] [ Delete] [F Fin ] [ Eancel]

Once the revision is created, a revision number is automatically assigned to the

drawing. The revision number is shown in the dialog box.

5. Check that the revision number is shown in the drawing list.

I L F U Created  odified Revizion Size Type

16.03.2005  16.03.2005

—

1M52*828 G

Mark | MName
[3] Steel frame

6. Open the drawing to check that the drawing title and revision table display the

revision information correctly.

1 A Profiles have been changed

16.3.2005

REVMa| REVMARK | REVISION DESCRIPTION

REVISION DATE

<® 7

LA Structures ®

DRAWING TITLE Steel frame

CONTRACT Tekla Corporation

MODELLED BY ISSUE DATE 00.00.0000
CONTRACT NO 1 SCALE 1:50

DRAWING No G I [ REVISION No. 1]

and information. To attach the same revision information to

f Several drawings can share the same revision mark, date,

several drawings simultaneously, select multiple drawings

from the drawing list.

N You can choose whether Tekla Structures shows the revision
numbers or the revision marks in the drawing list. By default,
revision numbers are shown. For more information, see the

following links:

Help: Drawing > Getting started with drawings > Defining

drawing revisions

Help: System > Files and folders > Startup batch file.
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_M?dify revision To modify the revision information of an existing revision mark:
iInformation

1. First create a new revision to the G [1] drawing by following steps 2-5 presented
above:

e Change the model

e Use B as the revision mark

e Type revision date and description

e Click Create

e Leave the Revision handling dialog box open

2. Select the revision number 2 in the drop-down box next to the Mark field. The
corresponding revision information is shown in the dialog box.

Change the revision mark to ¢, modify the description text, and click Modify.

4. Open the drawing to check that the modification is shown correctly in the
revision table.

Delete revision To delete a revision mark:
mark

1. Select the revision number 2 in the Revision handling dialog box.
2. Click Delete.

3. The updated revision number of the drawing is now 1. Check that the revision
number is shown correctly in the drawing list. Open the drawing to check that
the revision table is also updated.

M1/_  When you delete a revision, Tekla Structures automatically
Q adjusts the remaining revision numbers for that drawing.

Show revision mark in plot file names

When you plot drawings to files such as DWG, DXF or PDF, you can include the
latest revision number or mark in the plot file name. In the Plot dialog box, select the
checkbox of the Include revision mark to file name option as shown below.

[ﬂ Plot

Flotters:

_  [#]Plat ta file
e 'xdrawmgs | Browse...
designjet_al
desimijet al
laserjetdwv_al | Scaling
laserjetdyv_ad )

|
I |nchude: revizion mark to file hame |
|

(%) Ao

Show revision information in a report

The report drawing_issue_rev shows the revision dates and revision information of
drawings. For more information about reports see Lesson 9 Numbering and Reports.
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Show revision
information in
report

To create a report containing the revision information:

1. Click on the Report icon on the Standard toolbar to open the Report dialog box.

2. Select the drawing_issue_rev from the report list and click the Create from all

button.

[l Report

| Report i_-lfl_;_:glti;:-ns

Repart termplates:

assenbly _bolt listz
assenbly oo

azsembly list
assembly lot list
assemhly part hole list

assenbly phase list
assembly_stud list

bolt list

bolt list shop_only
bolt list site only
cast_unit eg

cast unit list

Save| [ Load E_?_tﬁf]_';'ﬂj :'_| [Sa\-'e as] gstandard I

Title= in reports

Report file

M
= | Tite1!
0| | |
Title2:
I |
Tithe3:
| |
9|

I arme; Iassembly_part_list.mr

|[ Browse. .. ]

[ Show H Prirt... ]

[ Create from alI] [ Create from selected ]

Cancel

3. Click on the show button to open the report.

4. Check that the revisions are shown correctly in the report drawing_issue_rev.xsr
(Tekla Structures creates the report in the model folder).

See the picture below as an example of the drawing_issue_rev report. Revisions

made to the G [3] drawing are marked with a red rectangle.
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TITLE: PHASE: Date: 25._0&_E003
DRC NAME  TEV.MARE DATE  DpEScRIPTTON TsaUE DATE
[ [1] Z23.05. 003
[ [£] Z3.05.Z003
[ [3] Z3_.05.Z003
= [2] A EZ3.E.032 Details and dimensions ch Z3.05.E00Z
[ [3] E 2a.E5.032 Dimensions changed 22.0E5_Z00Z2

Create revision marks in drawings

Define revision
mark appearance

We will create revision marks in the drawings to help locate the changes made to the
model.
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For more information about creating revision marks in drawings, see Help: Drawing
> Editing drawings > Editing drawings reference > Create>Revision mark.

To create a revision mark in the G [1] drawing:

Select the G [1] drawing in the drawing list and click on the Update marks
button to update all marks.

2. Open the selected drawing and check that the part mark of the column on
gridline 1 in the GRID A view has changed.
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3. Select Properties > Revision mark... from the menu to open the Revision mark

properties dialog box.

4. Select the revision number 1 in the drop-down box next to the Mark field to

obtain the corresponding revision information.

(¥l Revision mark properties
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5. Onthe Appearance tab, select the Arrow type as shown below, change the Frame

color of the revision mark to red and click OK.
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[# Revision mark properties

i_w -.-’;‘-.ppearance A
Test
Colar; :_ :l
Height: 250 |
Font: {ramsimn ! [ Select... J
[#] Anale; :'19
Ao Frame
Type! | —+ || EITee 23] v
—m=] i-2_|:"j —| Leader line: i_:’_i
—tl iﬂl Colar: |_—v|
[ Ok ” Apply ] [ bt ouclify ] ’ Get ] ['7 _c"" |_J ’ Cancel I

Create revision 1. Select Create > Revision mark > Arrow on right from the menu and pick a point to

mark in GA
drawing

gridline 1 in the GRID A view.

place the mark. For example, pick close to the column and its part mark on

2. Double-click on the revision mark to obtain its properties. Check that the

contents of the revision mark is correct, and its appearance corresponds to the

properties set in step5.
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